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AiM Software HD 3.0 User Manual
AiM 3.0 Software is a total solution for managing Acumen’s network products including IP
cameras, DVRs/NVRs, and AiM 2.6 Software. AiM Software HD 3.0 contains (1) network video
recording software, (2) eMap Manager, (3) Database Manager, (4) Web Server, and (5) Remote
DVR/NVR playback and file download.
Major features include managing video of IP cameras, DVRs’/NVRs’ cameras, and AiM’ cameras.
Recording of remote IP camera’s SD card, DVR/NVR, and AiM can be retrieved. Video playback
and file download are supported. Camera groupings with user authentication are integrated
within one system application.
One important feature of eMap is the central management system for live monitoring, alarm
snapshot management, and map management. IP devices installed at different locations can be
represented and managed by using maps.
Circular recording, schedule recording, individual HDD recording configurable, and individual
camera recording configurable provide the flexibilities in managing recording storages. AiM3.0
Software is designated for hybrid solution for IP camera, video server, IP Fast Dome, and
DVRs. It provides total solutions for digital surveillance. Major features are:

AiM Software HD 3.0 Main Features
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.

Record and manage video of IP cameras, DVR’s/NVRs’ cameras, and AiM
cameras.
Scheduling, continuous, and motion detection recording supported
eMap live video with alarm snapshots
Integrated alarm management for alarm output
Web server for live video and PTZ control
iPhone and Android phones support
Retail and transportation business solutions
Device grouping and recall
IP Fast Dome control
Export recorded video to AVI file format
Easy-to-use calendar and time selections for video playback
User access levels configurable for groupings and features
Complete operational event logs
Two-way audio and audio recording
Digital zoom, device ePTZ and ROI supported
Dynamically video channels swapping with mouse drag-and-drop

Copyrights
Acumen Inc. Co. holds exclusive ownership of the software and all intellectual property rights
embodied therein, including copyrights and valuable trade secrets incorporated in the
software's design and coding methodology. The software is protected by international treaty.
This agreement provides you with only a limited use license, and does not grant you any
intellectual property rights in the software.
Adobe and Acrobat Reader are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.
Windows, Windows 2000, Windows XP, Windows Vista, and Windows 7 are registered
trademark of Microsoft Corporation in the United States and other countries
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General Notations
The terms of IP-based devices or products used in this document refer to H.264 HD/JPEG IP
Fast Domes, Video Servers, or IP Cameras. The terms of DVR devices/products refer to DVR
3 and 5 series.

Before Using AiM Software HD 3.0

AiM Software HD 3.0 contains video recording. AiM Software HD 3.0 supports
multiple hard disk drives recording. If overwritten setting is enabled, the oldest
recorded video clips get deleted first. If you want logical partitions in your hard
disk drive, please setup at least 20 GB for each drive. To setup hard disk
setting, please click on “System Setting” button.
Select recording hard drives for AiM Software HD 3.0
recording. To enable HDD overwritten option, please
check this option.
Furthermore, each logical HDD drive should contain at least
10% empty space for storing video data. AiM Software HD
3.0 deletes the oldest files first until it reaches 90% of the
logical drive, and it proceeds to the next logical hard disk
drive for recording.

On-line User Manual
AiM Software adopts Acrobat Reader for its on-line manual by clicking on “Windows-> AiM
Software HD 3.0>User Manual”. You must install Acrobat Reader before opening the online manual.

Uninstall AiM 3.0 Software

To uninstall AiM3.0 Software, please select Start->Program Files->AiM Software HD 3.0>Uninstall. A user might want to export the database. Re-import the database after new
installation. Please see Database Manager for detail.

Using AiM 3.0 Software on Windows 7 and Windows 8 platforms
When you install AiM 3.0 Software on
Windows Vista and Windows 7 platforms,
please go to control panel->User Account
Control Setting and low the setting to Default.
This can make sure that AiM3.0 can login
automatically when watch dog performs
system reboot.
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Chapter 1.

Using AiM 3.0 Software

To access AiM 3.0 Software, follow these steps:
1)
Click on AiM3.0 Software via Start->Program Files->AiM Software HD 3.0
->AiM Software HD 3.0
2)
Click on AiM3.0 Software on desktop.
To login AiM 3.0 Software, please follow these steps:
Step 1. Select a user from User name dropdown list.
Step 2. Type the password or leave it blank if you are first time to use this software.
Step 3. Click on OK button.

Note: The default passwords for all users are empty.
Chapter 1-1. AiM 3.0 Software Registration
To get full features of AiM 3.0 Software and 108 channels support,
please click "Register" button, then provide your system ID and
your Mail Address for us, an unlocking key will be sent to your email
account after registration. Click on Help button for registration.

Provide email address and unlocking key to get full features access.
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Chapter 1-2. System Settings
System settings contain HDD settings, device settings, and grouping settings.
Please finish System Setting before operating AiM Software HD 3.0.

 Auto run this application when system starts:
AiM Software HD 3.0 auto-run when Windows starts
 Auto sequence after reboot:
Perform grouping sequence after system reboot.
 Full mode after reboot:
Perform full screen mode after system reboot.
 Original video resolution at full screen mode:
Use original resolution at single channel view mode. Do not scale original video.
 Auto login when system starts:
Bypass login when system starts.
 Default grouping:
Set default grouping at start-up.
 Auto minimized when system starts:
AiM Software HD 3.0 runs in the background when system starts.
 Default grouping:
Set default grouping.
 Default window division:
Set default window division at start-up.
 To enable circular recording, please check HDD Overwritten option. To select HDDs
for recording, please select HDD(s) for recording in HDD Information list box.
 System reboot:
enable the system to reboot every day at certain time.
 Language:
To choose language setting, please select your language from Language combo box.
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Chapter 1-3. Add a New Device
To add a particular device, please first select the channel and click on “Property”
button for adding a new device. The “Camera Settings” dialog box shows up.
Please type at least, IP/DNS address, port number, username, and password for
connecting the live video of the device. You can also click on “Find Device” and
selection one device from the IPScan tool. Click on “Detect” button for detecting the device
type.

To edit Camera Setting dialog box, please right mouse click on a channel and select Camera
Properties menu item.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

Name— camera name which is displayed on top of live video channel
Location—the location of the camera installed
Frame rate—frame rate for the device
Device type—device type selection box, RTSP is for H.264 D1 or H.264 HD IP cameras.
Enable recording—enable or disable recording for the device
IP/DNS (required)—the IP address of the device
HTTP Port number—the HTTP port number of the device
Video Port number—DVR’s video port number/IP camera’s RTSP port number
Username—the username which is allowed to login the device
Password—the password for the username
Image size—the source video size of the device
Camera/485 ID—IP Fast Dome RS-485 ID.
Synchronize Time with PC—Synchronize time with the remote PC.

-8-

Note: 1. RS-485 camera ID (1 to 128) must match the ID setting of the IP Fast Dome. The
software may not control PTZ movement if the ID setting is incorrect.
If the above settings are done, you can click on Connect button to test if the device is properly
For default username and password information, please see appendix for detail.
Chapter 1-4. Device Type
There are few device type drivers for connecting streaming:
RTSP—Connect an IP camera with RTSP streaming
protocol.
DVR/NVR-JPEG--Connect a DVR/NVR by MJPEG protocol.
DVR/NVR-H264—Connect a DVR/NVR by H.264 protocol.
AiM-JPEG—Connect a AiM3.0 Software by MJPG
protocol.
Low Bitrate IP Camera—Connect an IP camera by low
bitrate protocol.
Low Bitrate DVR Camera--Connect an IP camera by low
bitrate protocol.

Chapter 1-5. ONVIF Setting
To use RTSP streaming, please first setup ONVIF protocol.
described as below:










The detail setting of ONVIF is

Profile: a user can select different streaming profile such as H.264 720P or JPEG 720P.
Protocol: streaming protocol such as RTP/UDP, RTP/TCP, or RTP/TCP/HTTP.
Quality: compression quality
Brightness: brightness setting of the video
Saturation: saturation setting of the video
Contrast: contrast setting of the video
Sharpness: sharpness setting of the video
Frame rate: change frame rate setting of the IP camera.
Bit Rate: bit rate setting of the video
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Note: ONVIF setting can only be supported by Acumen’s ONVIF camera.
Chapter 1-6. IPScan Utility
To find out the network devices, IPScan utility can scan through all IP address within LAN.

A user can select a device item in IPScan and click on Close button to setup the device. All the
device information such as IP address and port number get automatically carried over AiM
Software HD 3.0. Click on Connect button in the device dialog box which can test the
connection between the PC and the device.
You can also manually add devices information of IP Fast Dome/IP camera/video server/DVR
Note: IPScan can only work under LAN environment, not Internet environment.
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Chapter 1-7. Alarm Input Management
There are various alarm inputs that are supported by AiM 3.0 Software.
explained below:








The details are

Remote Alarm In: Receive a digital input (DI) alarm from a remote IP camera.
Remote Motion Detection: Receive a motion detection alarm from a remote IP camera
or the camera of NVR/DVR. This can further save CPU usage of AiM3.0 Software.
Remote Face Detection: Receive a face detection alarm from a remote IP camera with
face detection feature built-in.
Remote Tampering Detection: Receive a tampering alarm from a remote IP camera
with tampering detection built-in.
External IO: Receive an alarm from Ethernet APG cash drawer or remote Ethernet IO
device.
Motion detection: AiM3.0 Software’s local motion detection.
Video Loss Detection: If the video loss detection is detected, this can trigger Play
Sound and Send Email for alert purpose.

Chapter 1-7-1. Ethernet Digital I/O Device
Ethernet I/O device such as Moxa ioLogik E1212 can be linked to an IP camera for extern alarm
input and output device. Ethernet digital I/O device is used, if the camera does not have DI/DO
built-in.

Map to the logical digital input and
digital output- 11
for- an IP camera.

Click on device scan which can find Moxa I/O device on the network. Once
one the IP address is selected, please map the logical digital input (DI) or
logical digital output for an IP camera. To activate digital output (DO), click
on Alarm On or OFF button.

Chapter 1-7-2. Remote IP Camera with Digital I/O
If an IP camera has DI/DO interface, enable Remote Alarm In (DI) in the
alarm input list. To enable alarm output, click on Alarm On or OFF to trigger
the digital output via the IP camera.
Chapter 1-8. Alarm Output Management
For motion and remote motion alarm detection management, the alarm output feature allows
various reactions after receiving an alarm. The alarm output includes (1) PC alarm sound, (2)
send JPEG email snapshot, (3) recalling a PTZ preset, (4) triggering a DO output for an IP
camera, (5) alarm full screen, (6) pre-alarm and post alarm. Please select the alarm output
from the selection list to enable the option.
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Chapter 1-8-1. Alarm Sound Alert
To select pre-recorded alarm audio, click on Alarm Audio button for choosing the WAV file.

Chapter 1-8-2. Alarm Redirects to a PTZ Preset
If an alarm gets fired, it can redirect another IP camera’s’ preset for a video.

Chapter 1-8-3. Alarm Redirects an IP Camera’s Digital Output
Once an alarm gets fired, it can redirect the signal to another IP camera’s digital output.

Chapter 1-8-4. Re-alarm & Post-alarm
Re-alarm and post-alarm recordings are triggered by an alarm event. The recording period is
based on Pre-alarm and Post-alarm dwell setting. Pre-alarm & post-alarm can further save
recording storage. The video get recorded for a period, after an alarm gets fired.
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Chapter 1-8-5. Alarm Acknowledgment
For alarm acknowledgment, please first prepare two monitors, one for AiM3.0
Software and another for alarm acknowledgment. Click on Monitor Setting button and
set “Alarm ACK Monitor” to the second monitor.

AiM3.0 Software main monitor

Alarm acknowledgement monitor

If there is an alarm on AiM3.0 Software main monitor, the video gets displayed on the AiM3.0
Software alarm acknowledgement monitor. To acknowledge the alarm, click on “ACK OFF”
button on the AiM3.0 Software alarm acknowledge monitor.
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Click on “ACK OFF” button
to acknowledge the alarm.
To setup acknowledge feature, please enable “Alarm ACK” on the alarm output selection.

Chapter 1-8-6. Notify to another AiM 3.0
AiM 3.0 Software CGI triggering allows CGI commands to enable and to disable the video on
the alarm acknowledge monitor of third-party software automation.
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Chapter 2.

Recording Settings

AiM Software HD 3.0 is configured as continuous recording after an IP camera is
connected. To change recording configuration, please follow the following selections.
Chapter 2-1. Schedule Recording Settings
AiM Software HD 3.0 can schedule recording based on “Always”, “No Record”, and
“Motion recording for a particular hour.
To enable recording for a particular hour, please click on the week control and set the recording
option for the hour. Please also specify the recording type by selecting one of the recording
types.
To enable recording schedule for all hours, please click on Apply button for “Apply All Schedule”.
To apply the recording settings for all cameras, please click on Apply button for “Apply Schedule
to All Channels”

Chapter 2-2. Motion Detection Recording
To enable motion detection recording, please click on camera “Property” button to
enable “Camera Settings” dialog box. Once the IP camera is configured properly,
please click on “Video” button to test the video streaming.
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Please click on “Motion” button to setup motion detection. There are up to four motion areas
available for a user to configure. Perform mouse-dragging on the video area to define a motion
area. Perform right-mouse click can clear a area or clear all areas. To change motion
detection sensitivity, please click on the scroll bar for adjust.

At live monitoring mode, if a motion detection is triggered, the camera window shows “little man”
to indicate a motion detection event.

For remote motion detection, please select “Remote Motion Detection” option and “Option”
button to configure motion detection zones. Remote Motion Detection dialog box shows up.
Click on the motion grid area and perform mouse-drag on the grids to define motion detection
- 17 -

zone. Make sure Motion Detection check box is enabled.
configuration gets download to an IP cameras.

Click on Apply button that the

Note: The use of Remote Motion Detection can further reduce the CPU load of a AiM PC,
since it utilizes the motion detection engine of an IP camera.

Chapter 2-3. Recording at System Startup
After the restart of AiM Software HD 3.0, AiM Software HD 3.0 starts recording automatically.
There is no need to restart recording service. If a schedule is set, AiM Software HD 3.0
records video based on the schedule at startup.
Chapter 2-4. Estimated Recording Days
After system installation, to estimate approximate recording days, a user can click on
System setting button to enable system dialog box. Click on “Record time” tab.
Estimated recording day and time information gets shown on the dialog box.
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Chapter 2-5. Network Storage NAS
For recording over network storage such as iSCSI or NAS storage, a user can configure AiM
Software HD 3.0 to record the video to the network storage, if the network storage supports
“Network Neighborhood” protocol.

To do so, please first select a drive at “Add Network Drive” list. Select network storage by click
on “Mapped Drive of AiM3.0 Software PC” button. Once the network storage is selected, click
on Apply button. At the last, please check the newly added network storage from Drive Number
for enabling the storage. AiM3.0 Software records video based on the selected drivers at
circular recording basis.

For "Map Network Drive", please make sure that "Reconnect at logon" option is checked.
can avoid losing connectivity from AiM3.0 Software due to network driver rebooting.
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This

For adding a network driver for AiM3.0 Software, please select one of the PC HDD or network
HDD. Perform right mouse click on the HDD. Click on "Map Network Drive." menu item. "Map
Network Drive" dialog box shows up. This can add the network storage into the AiM3.0
Software’s storage drive.
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Chapter 3.

Grouping Settings

A user may want to manage camera or DVR groupings based on their geographic
locations or their functions. The video of the grouping devices can be recalled easily
later on. To setup groupings, please click on the Grouping button and follow the
followings steps.
1.
2.
3.

Select left IP Cam/DVR grouping and select right grouping item. Click on Right button
to create a grouping.
Click on Up or Down button to change the sequence in Grouping tree view.
Click on Apply button for the grouping settings.

Once the groupings are set, a user can switch to different grouping view quickly.
Chapter 3-1. Grouping Name
A user can assign a name for a grouping. To assign grouping name, please right click on a
grouping, or select on a grouping and click on Property button for its name. Type the grouping
name in Grouping dialog box.
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Chapter 3-2. Grouping’s Devices
Once a grouping is set, please select the device of the grouping. Right click on the
pre-assigned grouping device item. Select on the device item and perform right mouse click
for assigning Property.

Chapter 3-3. Grouping Authentication
To assign a grouping access right, please right click on a grouping and select Property menu
item. It shows a Grouping Access dialog box. The default setting of a grouping allows every
user to access. To disable access right, please uncheck a user access right. Grouping
access right also applies to web server. Only groupings assigned to a user can be seen by the
user after login to the web server.

Chapter 3-4. Recall a Grouping
To recall a grouping, click on grouping drop down list.

Chapter 3-5. Grouping Sequence
In grouping tab, please specify Sequence Time.
button to perform Sequence Display feature.
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In live monitoring mode, please click on SEQ

Chapter 3-6. Main Grouping
Main Grouping refers to AiM Software HD 3.0’s main screen which contains 36 windowsdivision screen. To add a device for the main grouping, please follow the steps:
(1) Select Main Grouping in grouping dropdown list.
(2) Right mouse click on one of the cameras.
(3) Select Camera Properties to assign the camera properties.
Alternatively, a user can add devices into Main Grouping at System Settings->Device Settings.
Device Settings allow a user to manage up to 36 channels of IP cameras, video servers, and
H.264 HD IP’ cameras.

Chapter 3.7. Window-divisions
Currently, AiM Software HD 3.0 supports four types of window-division including
maximized window (each view), 4-window-division, 16-window-division, and 36window-division. To see the maximized camera window, you can select particular camera
window and click on Each View button. You can also double-click on the live video for the
maximized window. To see 4-, 16-, and 36-window-division, click on the window-division
buttons.
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Chapter 1.0. Dynamic Video Channel Editing
If a user wants to change the arrangement of a camera channel, the user can drag a camera
and drop to another video channel. This operation swaps these two cameras’ positions
dynamically in software. There is no need to re-assign all the IP settings, if the user later
changes his/her mind for the camera’s display position after installation.

Drag-n-drop

Chapter 3.9. Digital Zoom
To perform digital zoom, please first drag on the window for digital.
digital zoom mode, please select the green area for other region.
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Once the channel is in

To perform digital zoom in playback, please follow above procedure.
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Chapter 4.

AiM Software HD 3.0 Video Playback

AiM Software HD 3.0 can perform video playback task for all IP-based products including
H.264 HD IP Cameras, full D1 IP Cameras, IP Fast Domes, Video Servers, LAN Cameras, and
DVRs. To perform video playback on various IP devices, follow the following sections:
Chapter 4-1. Playback
To perform playback operation, you have to select a camera channel or a DVR.
clicking on playback button, the playback dialog box shows up.

By

Based on a DVR device or an IP camera device, each device of the playback operation is
described in the following sections:

Chapter 4-2. Playback for an IP Camera within the Main Grouping
For the main grouping, the video can be recorded at a local PC. To
retrieve stored video clips, playback operation can be performed
based on date and time specified. Please follow the following steps
to play video clips on the PC:
Step 1.
Step 2.
Step 3.

Click on the date on the calendar control.
Specify starting time and ending time.
Click Search button to search the video clips.
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Continuous Recording

Alarm Recording

Once a video clip is playing, click on Stop, Play, Pause, <<, >>, and snapshot buttons
for the video clip. A user can also click on the time-bar for video playback.
Chapter 4-3. Multiple Channels Playback
A user can select a grouping for multiple channels playback. To do so, please click on multiple
channels’ playback button. A playback dialog box shows up as below:

There are up to 36-channels playback that is available in the system. Please specify date and
time. Perform Search button for playback task.
For multiple channels playback, the setting shows (1) I frame only (2) I frame only. I frame only
is when multiple channels playback is activated. The background AiM3.0 Software shows 1
frame/sec for reducing CPU load. This setting is recommended to be checked. I frame only is
for multiple channels playback showing only 1 frame/sec to avoid CPU usage. This setting is
recommend to be unchecked if CPU usage is low.
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Note: Uncheck I frame only for higher frame rate display for smooth video while playback.
Chapter 4-4. Remote AiM3.0 Software Multiple Channels Playback
A user can perform playback on a remote AiM3.0 Software for its video recording. To
do so, click on "Remote Playback" button. Click on "Connect" button and enter IP/DNS
address, port number, username, and password for accessing the AiM3.0 Software.
Select a grouping for multiple channels playback.

Connect Button

Chapter 4-5. SmartSearch
In AiM3.0 Software multiple channels mode, SmartSearch is supported for quick video search
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in which motion detection zones can be defined for an instance of the recording.
To use this feature, enable full screen mode for a particular camera. Select SmartSearch
option from “Select Mode” option. A SmartSearch gets prompted; drag the motion area on the
video of the SmartSearch dialog box. Click on Start button can start to quick scan through for
the motion activities of the recordings.
The snapshots of the motion activities get displayed in the
event list. Click on the snapshots that can quick play the
video for a particular event.

Drag on the video for
SmartSearch zones

Chapter 4-6. Remote DVR/NVR Playback
For playback on a remote DVR/NVR, please first perform
right-mouse click on a DVR/NVR channel. Select
“DVR/NVR Remote Playback” menu item for DVR/NVR video
playback.

The DVR/NVR Playback dialog box shows up. Specify date
and time information in the dialog box for remote DVR/NVR
playback.
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Chapter 4-7. Remote DVR/NVR File Download
To download remote DVR/NVR’s files, please first perform right-mouse click on a DVR/NVR’s
channel. Select “DVR/NVR File Backup” menu item. A DVR/NVR File Backup dialog box
shows up. Specify date, time information, and click on Search button. It can list all the files of
the DVR/NVR. For downloading the files, please click on Save Folder button and click on
Download button for downloading the files into a specific folder.

Chapter 4-8. AVI File Exporting & Play From a File
Exporting AVI with OSD
To export an AVI file for main grouping device, please perform playback operation for the device.
Once the video clips have been located, specify the file name and click on Save Now button for
the AVI file.
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Exporting AVI without OSD
For direct exporting H.264 AVI file without OSD time stamp, this operation performs fast than
rendering OSD.

AiM Software HD 3.0 video clips are stored in a hard drive’s Video folder followed by a GUID
folder. The GUID folder is a 32-digit hex folder. AiM3.0 Software HD 1.0’s video clips are
stored as in the folder under year, month, day, hour, and minute. To retrieve a particular a file,
please locate the file by the button of “Play from a File”.

Chapter 4-9. Multiple Channels Backup
Multiple channels backup feature can be done for (1) multiple channels playback by
the player, MPlayer, (2) multiple AVI files for both local and remote backup.
To do so, click on Backup button and selection channels. Specify date, time, and
destination directory. Finally, choose Start Backup or Covert AVI button for multiple channels
video backup.
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Chapter 4-10. Snapshot
For IP-based devices, you may want to capture a particular video into a picture. You
can click on the Snapshot button. The picture is exported to a JPEG file format. For
DVR devices, please perform right-mouse-click and select “Save As JPEG” menu item.

Chapter 4-11. Alarm Event Playback
To playback based on motion detection events, please click on the alarm radio button at the
Playback dialog box. Click on Search button to list all the motion detection events. Click on a
motion event can play associated video.
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Chapter 4-12. Tagging
For important video clips, tagging feature allows to mark these video clips without
overwritten.
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Chapter 5.

Audio

Chapter 5-1. Two-way Audio
To perform two-way audio, please first select a particular channel for listening to the audio of the
channel. Click on Speaker icon to enable audio feature. To change volume, please change
volume bar.
To speak to remote site, please click MIC On button.
To enable audio monitoring, please double click on a channel in full screen
mode for audio monitoring.
Chapter 5-2. Two-way Audio Auto Switching
AiM Software HD 3.0 supports two-way audio for IP cameras. Enable "Audio Auto
Switch" button which allows automatically speaking to remote site and listening to
the audio, when the camera is triggered by the remote IP camera’s digital input.

Chapter 5-3. Audio Recording
For IP cameras with audio input models, AiM Software HD 3.0 can record audio with its
video. To listen to the audio recording, playback feature can play the audio.
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Chapter 6.

Archiving Manager

AiM Software HD 3.0 Archive Manager can archive video to a central network storage. Archive
Manger is located in each AiM3.0 Software PC. It can perform video clips archiving to the
central storage automatically.

Chapter 6-1. Archiving Source
To perform video archiving, select the cameras for video archiving. You can keep the video
clips from the AiM 3.0 Software PC (Duplicate Archiving), remove the video clips from the
AiM3.0 Software PC, or choose the time not for archiving. After configuring above, you can
schedule the archiving task starting at specific hour of the week of the camera or apply all for the
schedule to other cameras.
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Chapter 6-2. Archiving Destination
A user can choose the Archive Driver for archiving the video clips from a AiM3.0 Software.
The Archive Drive could be a network RAID drive or internal SATA RAID for large among
data. For a network RAID (NAS), click on "Setup Network Disk" button to attach the drive to
the AiM3.0 Software. After setting up the archiving drive, select Real-Time Archiving or
Scheduled Archiving. For the Read-Time Archiving, the archiving task is activated in the next
minute. After the configurations, a user can click Start button for archiving task.
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Chapter 7.

User Settings

User setting allows add a user, delete a user, change password for a user, and
assign feature accessed by a user.
To add, delete, and modify a particular user, click on User button in NVR tool box.
The User Setting dialog box shows up.

Chapter 7-1. Add a User
To add a user, click on a particular user in the user list and click Add button. Add User window
shows up. To add user, specify user name, password, and confirm password. Please also
specify the user level and click on OK button.

Chapter 7-2. Modify an Existing User
To modify an existing user, click on a particular user in the user list and click Property button.
To modify the user, specify user name, password, and confirm password.

Chapter 7-3. Delete a User
To delete a user, please select the user in user setting window and click on OK button.
Chapter 7-4. User Authorization
Features of AiM3.0 Software can be assigned for a user. To enable a feature for the user,
please first click on Property button. The User Property dialog box shows up. Click on the
check box for the user in Access Level list item.
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Chapter 7-5. Alarm Email Notifications
For sending alarm email notifications, please configure the email setting in the user. After
finishing email setting, please configure Alarm Output Management at Camera Settings.
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Chapter 8.

PTZ Control Panel

In order to perform PTZ movements, you have to select a particular live channel
which contains an IP Fast Dome. Once an IP Fast dome is selected, you can
control the movements using PC keyboard and/or PTZ control Panel.

Chapter 8-1. Preset Point Settings
To setup preset points, please invoke Presets dialog box.
Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Follow the following steps:

Select preset point dropdown list.
Type the time field.
Type the speed field.
Click up, down, left, or right to move the IP Fast Dome to specific position.
Click Apply button to set the position.
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Chapter 8-2.

AiM Software HD 3.0 Status Panel

AiM Software HD 3.0 status panel is described as following chart.

System date

System time

Recording percentage of HDD
CPU usage
Speaker status

MIC status

User status

Chapter 8-3. Control PTZ via Ai-CO99 Keyboard
To use Ai-CO99 keyboard for AiM3.0 Software, please follow the following steps. First,
please add a RS-232<->RS-485 convertor for connecting Ai-CO99 keyboard and a AiM3.0
Software PC.

RS-232<->RS-485 Convertor

Chapter 8-3-1. DVR Control Mode
Press the SHIFT button and the DVR button to set the keyboard to DVR control mode.
+
To control a AiM3.0 Software, please first enter the DVR ID (AiM3.0 Software ID) follow by the
ENT button.
+

+

To recall a grouping, please type 1 + MON and following by grouping ID and the PRESET
button.
+

+

+
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Chapter 8-3-2. Window-division
To change window-division, please first control a AiM3.0 Software and type the following
buttons.

16-division

8-division

9-division

4-division

36-division

AiM3.0 Software ID + DVR +
ENT

To recall 36-window-division, please type AiM3.0 Software ID followed by DVR and ENT
buttons. The operation is same controlling a AiM3.0 Software.
Chapter 8-3-3. Recall a Camera
For recalling a camera, please select camera number and follow by CAM button.
Example: Call camera #8

+

+
Zoom in

Zoom out

Tilt up

Tilt down

Pan left

Pan right

Zoom in

Zoom out

Focus near

Focus far

IRIS small

IRIS large

Auto Pan

Chapter 8-4. IP Camera ePTZ or ROI Feature
For some IP cameras, they provide ePTZ or ROI feature. A user can still use the keyboard
controller for ePTZ or ROI feature via AiM Software HD 3.0.
Chapter 8-5.

Switching in Between AiM3.0 Software and Virtual Matrix Monitors

Please first gain AiM 3.0 Software access by press SHIFT button and DVR button.
+
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To control the AiM3.0 Software, please type AiM ID, DVR button and ENT button.

+

+

After a AiM3.0 gets controlled, a user can address the monitors of the AiM3.0.
+
To control #5 monitor, please click 5 button + MON for controlling #5 AiM3.0 monitor. To recall a
grouping, please type the monitor ID + MON and following by grouping ID and the PRESET
button.
Chapter 8-6. Keyboard Playback
Please press SHIFT and DVR buttons for playback a AiM3.0 and press one of the follow
buttons for playback.
To control multiple channel playback feature, please click on Stepping Forward button. This
invokes multiple channel playback features.
To control multiple channel playback feature, please click on Stepping Forward button.
This invokes multiple channel playback features.
To control single channel playback feature, please click on Play button.

A date and time dialog box shows up. Please use
for entering date and time. Press ENT
button for searching the video. Press ESC to exit the dialog box and press ESC again to exit
playback dialog box. For operating playback features, please follow the following:
Pause: Press PAUSE button during playing video can pause the video in pause mode.
Play: Replay the video after Pause, Fast Forward, or Fast Rewind.
Fast Forward: Fast Forward the playback video.
Fast rewind: Fast Rewind the playback video.
Stop: Stop the playback video and return to playback menu.

Select various split display modes on live and playback monitoring.
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Chapter 9.

eMap Manager

eMap is an application which can manage devices such as IP camera, IP Fast Dome, and
DVRs/NVR on multiple maps. With eMap, user can easily locate a particular device on a map.

Chapter 9-1. Before Accessing eMap
Before accessing eMap, terms and screen layout are described in the following section:
Alarm Snapshot

Camera with Camera View

Multiple Live Video

Alarm Snapshot

Map Representation

Device Tree

Find Device Panel
To find a device, please click on Find Device Panel button or View->Device menu.
Click on the device in Find Device Panel.
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PTZ Control Panel
To control PTZ device, please double click on a PTZ device.
PTZ feature on the PTZ control panel.
Chapter 9-2.

Perform

Tool Bar

The buttons from left to right are described as follows:

New map: Create a new map.

Find device panel: Switch to Find Device panel

PTZ control panel: Switch to PTZ control panel.

Refresh: Refresh eMap map list and device information.

eMap edit mode: Drag a device on a map for its position.

Device list panel: Switch to device list panel.

Find alarm panel: Switch to find device panel.
PTZ control panel: Switch to PTZ control panel.

eMap alarm switching mode: Switching in between map if an alarm gets received.
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eMap control mode: for PTZ control and live monitoring mode
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Chapter 9-3. eMap Alarm Options
Continuous snapshots: For every alarm, number of
continuous snapshots is taken.
Alarm snapshot interval: The time interval of the alarm and
next alarm detection
Alarm video output time: The video output time
Number of snapshots stored: The ring buffer size for
storing JPEG snapshots.

Alarm video output

Chapter 9-3-1. Setup a Map
To setup a device map, click on File->New Map or New button at Map list. A file opening dialog
box gets displayed. Please select the JPEG map file representing the installation site. Type
both map name and location information.

To delete a map, please first select the map in Map List and click on File->Delete Map or click on
Delete button.

To access property of the page, click on Property button.
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Chapter 9-4. Setup a Device on a Map
To setup devices on a map, drag-and-drop a device from Device List to its associated
map. The device item shows checked if the device is setup on the map.

Chapter 9-4-1. Delete a Device on a Map
To delete the device on the map, follow the following steps:
1.
2.
3.

Select on the device.
Right click on the device.
Select “Device Delete” menu item.

Or, uncheck the check box of the device item.
Chapter 9-4-2. Arrange a Device
To arrange the device position on the map, click on Drag Mode tool or menu item to
enable device drag mode. Use mouse point drag the device to the destination
area.
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Chapter 9-4-3. Device Property
To show a Device Property, select “Device Property” menu item
on the menu. A Device Property dialog box shows up.
Device name and device text color can be changed for
distinguishing its background image.

A camera view control can indicate a camera’s viewing angle. To setup camera view control,
please click on the clockwise/counter-clockwise control to rotate camera viewing angle.

Chapter 9-5. Find a Device on eMap
DVR, DVR’s camera, or IP-based devices can be setup on
different maps. It is very difficult for a user to find the live
video of a particular device. To find a device on eMap
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instantly, a user can click on Find Device Panel button/View->Find menu item. List of all
devices in Find Device Panel can be found on a map instantly. The user can click on the
device that eMap can automatically switch to the map and show the device and its live video.
Chapter 9-6. Alarm on eMap
If a motion or a digital input alarm is received from AiM3.0 Software, eMap can
receive the alarm signal from AiM3.0 Software. The camera is shown as
blanking on eMap. The associated video can be displayed on eMap.

Chapter 9-7. Quick Map Reference
In eMap edit mode, click on a map and drag it into map view.
from one map to another by click on the map icon.

Drag and drop
drop
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This allows quick switch

Chapter 9-8. Alarm Control Mode & Switching Mode
Alarm control mode is for the use of frequently switching in between maps with video window(s)
opened. A user can manually double-click on the camera icons for its live video. There are up
to 4 windows that can be opened at same time. When switching from one map to another, the
video window(s) on current map get closed. The next map with previous opened video
windows(s) can be opened automatically. The feature is very useful if the maps need to be
opened frequently.

In contrast, alarm switching mode is for automated map and video switching for showing the
video with associated map while an alarm is received. The feature is useful for alarm video
popping up.
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Chapter 10. Web Server
Each AiM3.0 Software has one web server for displaying live video.
please specify the port number of the PC’s IP address.

To enable the service,

Once this is done, the user can click on the HTTP Link and launch Internet browser to see the
video.

Chapter 10-1. Login Web Server
To login AiM3.0 Software web server, please provide the username and password for the
service. The live video is grouped based on grouping as in AiM Software HD 3.0. Once a
grouping is managed, the grouping can be assigned for its access right of a user. Please see
grouping section for detail.
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Chapter 11.

Database Manager

Database Manager allows a user to perform operational
report printing, event report printing, database importing,
database exporting, and database repairing.
To perform above features, please see the following:

Chapter 11-1. User Operational Report
For showing all logon logs, please click on “User Log Report” menu item. To print out
the report, please click on “Print/Print Preview” menu item.
Chapter 11-2. Event Report
For showing all alarm event logs, please click on “Event Report” menu item. To print
out the report, please click on “Print/Print Preview” menu item.
Chapter 11-3. Database Maintenance
Database maintenance is constantly required. To perform database maintenance,
please click on Tool->Compact DB or click on Compact DB tool button.
Chapter 11-4. Import Database
Database configuration can be imported from a XML configuration file.
database, please click on Import Database button.
Chapter 11-5. Export Database
Database configuration can be export to a XML file for later use.
exporting, please click on Export Database button.
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To import

To perform

Chapter 12. Setup Multiple Monitors
Multiple monitors support is a feature in Windows XP or higher. Multiple monitors support
allows you to expand the display across for both AiM Software HD 3.0 and eMap.
The benefit of adopting multiple monitors support is to
use one mouse/keyboard to control both AiM Software
HD 3.0 and eMap.

Multiple camera view in AiM

Software HD 3.0 and live video in eMap can be
operated by an operator on a personal computer.
To install additional monitors, you must first install the
compatible video adapter hardware into the PC and
connect the additional monitor.

To setup multiple

monitors support, read the instruction manual of
Windows XP.
Chapter 12-1. Multiple Monitors Virtual Matrix Output
AiM3.0 Software can up to support 6 monitors, one main monitor + 5 additional monitors.
AiM3.0 Software TV wall virtual matrix can be connected as the system described below: To
support 6 monitor outputs, please use ASUS 7970-DC2-3GD5 graphics card.

After installing the graphics card, click on Monitor button. It shows all the detected
monitors shown below:
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Once all the monitors are properly installed, click on "Identify Monitor". All monitors are shown
IDs as below:

Few functions for controlling AiM3.0 Software monitors are described below:





Quad display: for large LCD panel, AiM3.0 Software can be configured to show 4
AiM3.0 Software monitors on one big LCD monitor. Each monitor can be
36-windows display.
Default grouping: the default grouping to be shown on the main monitor.
Sequence time: the monitor can be programmed for sequence display.
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Division: the default camera division of the grouping.
Low CPU usage mode: this mode can only display I frame for reducing CPU time.

Chapter 12-2. AiM3.0 Software 2x2 Video Wall
AiM3.0 Software can support 6 monitors in which 4 monitors can be setup for 2x2 Video Wall
feature.

Please use “Control Panel->Display->Screen Resolution” tool for arranging these 4 screens to be
3840 * 2160 in total resolution. Each monitor should be 1920 * 1080 in resolution. Please
arrange the monitor sequence based on the following picture:

After getting the 2x2 license and with above setting, you will see a 2x2 button on top of the
AiM3.0 Software user interface.
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AiM Software HD 3.0 can arrange the 4 monitors on the wall with 3 36-windows and one
eMap.

Chapter 12-3. Alarm ACK Monitor
The alarm ACK monitor is another monitor which can be set for alarm notification monitor. Once
the feature is set for a monitor, the video gets display after receiving an alarm, the alarm is
required for deactivating the alarm.
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Chapter 13.

Retail and Distribution Business Solutions

AiM Software HD 3.0 is able to connect to Point of Sale (POS) terminals. POS transaction
data can be captured by AiM Software HD 3.0. POS transaction data can be displayed on live
video and playback video. AiM Software HD 3.0 also provides smart transaction search for
associated video clips. To perform these features, please follow the steps below:

Chapter 13-1. POS Connection Basis for Retail Business
AiM Software HD 3.0 basically listens to the ASCII/COM output of a POS system via
RS-232. Please check POS’s display output or printer output for ASCII data of your POS
system. Please consult your POS provider for more detail.

Basically, please connect RX/TX of the RS-232 of a POS register/terminal to AiM3.0 Software
PC. Please see wiring diagram below:

To connect more than one POS terminals, add more RS-232/COM port into the AiM3.0
Software PC.
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Chapter 13-2. POS Connection via TCP/IP for Retail Business
Using CYT-100SC RS-232 to TCP/IP converter, AiM3.0 Software allows receiving RS-232 of
POS transactions via TCP/IP. The product CD of CYT-100SC has one virtual driver which
can map the TCP/IP transactions to a virtual COM port. The virtual COM port can been
accessed via Windows OS. Once the virtual COM port is setup, follow the following sections
for the setup.

Chapter 13-3. Test POS Communication with a PC
After the POS connects to the AiM3.0 Software PC, please use Hyper Terminal or other
RS-232 capturing application to test and to verify POS data that can be captured in the
AiM3.0 Software PC.

Chapter 13-4. Link POS with a Channel
To link a POS to a camera, please click on “Property” button and “POS” button.
POS Setting dialog box shows up.
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The

In POS Setting dialog box, please specify the following information for capturing POS
transactions.
(1) Device: POS register number.
(2) COM Port: The mapped COM port number for the POS terminal.
(3) Print on Video File: Record POS transaction into video file.
(4) Print on Playback: Display POS transaction during playback.
(5) Print on POS Live: Display POS transaction at live video.
(6) Text Alignment: Alignment of POS transaction.

Once above information is setup correctly, AiM Software HD 3.0 starts to capture and to
display POS transactions on live video.
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Chapter 13-5. Playback with POS Transactions
During playback, the recorded POS transactions get shown on the video and displayed on the
list box. Click on a POS transaction. The video clip is played associated with the time of the
POS transaction.

Chapter 13-6. Search POS Transactions
To search a particular search conditions such as an amount, a product item, subtotal, and total, a
user can set the search condition for associated time stamp. Click on the item in the listbox. It
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can play the video of the transaction.

Chapter 13-7. Scanner Connection Basis for Transportation Business
For transportation business, a barcode scanner and a keyboard are widely used. The barcode
scanner for scanning barcode is connected to a PC via the PS/2 connector of the AiM3.0
Software PC. The barcode scanner acts as a keyboard. In AiM Software HD 3.0, the
scanner connection only accepts 0 to 9 for keyboard scanner or the barcode scanner.
To use barcode scanner as transaction device, connect barcode scanner into PS/2 connector.
In “Camera Settings” dialog box, enable “barcode scanner” option. For one PC, there is only
one video channel that can be set for the barcode scanner.
For search barcode transactions and playback on the barcode transaction, please see “Playback
with POS Transactions” and “Search POS Transactions” for detail.
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Chapter 14.

Mobile phone support

Please use your smart phone and visit AppStore or GooglePlay for download
Acumen Air Viewer application. For more detail, please visit Acumen Air
Viewer application note.

Chapter 15.

AiM3.0 Software Streaming Client & Server

AiM3.0 Software provides client and server architecture where a AiM3.0 Software server can
stream video to a AiM3.0 client. This can further reduce CPU loading from an IP camera. The
system architecture is described below:

Chapter 15-1. AiM3.0 Streaming Server
To enable AiM3.0 streaming, click on System Setting button and enable Network
tab. Check Streaming Server opton and specify the Listen Port number.
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Once the streaming server is enabled, a proxy program is activated if AiM3.0 Software is
launched. Please do not close AiM3.0 Software Streaming Server proxy program, if remote
live monitoring from AiM3.0 Software server is required.

Chapter 15-2. AiM3.0 Software Streaming Client
To enable live monitoring from a AiM3.0 Software server, click on Properties button.
Select AiM3.0 Software Live Streaming driver. Provide IP address and port number of
AiM3.0 Software streaming server.
Due to bandwidth management, SD streaming and HD streaming can be selected.
bandwidth is very low such as Internet, Low Bitrate mode can be selected.

- 63 -

If the

Chapter 16.

AiM3.0 Software ANPR Plug-In

AiM3.0 Software automatic number plate recognition (ANPR) is a plug-in of the USB license
dongle which allows AiM3.0 Software to perform ANPR feature. Features such as white list,
black list, and exclusion list are supported in AiM3.0 Software. For more detail, read Acumen
AiM3.0 Software ANPR manual for detail.
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Chapter 17.

Failover

AiM3.0 Software Recorder is a hardware solution based on AiM3.0 Software which has Failover
feature built-in. One of the AiM3.0 Software Recorders can be setup for Failover feature.
Failover feature is a monitoring service for the other AiM3.0 Software Recorders. Firstly, if one or
more cameras get lost for its network connection, the Failover AiM3.0 Software Recorder can
take over the network video for recording purpose. Secondly, if one of the AiM3.0 Software
Recorders is in maintenance, the AiM3.0 Software Recorder with Failover feature setup can take
over the recording.

Chapter 17-1. Enable Failover Monitoring Service on the AiM3.0 Software Recorder
For the Failover monitoring server (server-end), please click on System Settings
button and on Failover tab. Select on one of the Failover clients and specify the host
IP address, port number, username, and password to enable the monitoring service.
The default port for AiM3.0 Software communication is port 8080. To enable
Failure alarm, please select “Auto Alarm Loop”.
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Chapter 17-2. Enable Failover Cameras on the AiM3.0 Software Recorders
On the other AiM3.0 Software Recorders (client-ends), first go to Failure table at System Settings
and enable “Failover Client Mode”. Second, please setup the cameras to be monitored. Check
on “Failover Enable” check box to enable the monitoring service.

After finishing all the cameras on AiM3.0 Software Recorders, go back to AiM3.0 Record
(server-end). You will see up to eight Failover groups. Each Failover groups contains up to
36 channels.

Once all the server-end and client-ends are properly configured. At AiM3.0 Software
Recorder (server-end), you can click on Get button to see all the monitored cameras.
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For playback of the Failover recordings, click on Multi-playback button.
control indicates the Failover recordings.
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The calendar

Chapter 18.

Trouble Shooting

Chapter 18-1. What should I do if I experience video flickering in AiM3.0 Software
If you experience video flickering at AiM3.0 Software of the PC’s graphic card, please follow
the instruction for solving the problem.
Step 1: Please go to “Control Panel->System and Maintenance->System Properties” at
Windows 7.

Step 2: Click on “Performance Setting” button and select “Adjust for best performance” option.
It can solve the flickering problem.
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APPENDIX
Minimum System Requirement
OS:
Windows XP Home, Windows Vista Home, SP3 required, Windows 7 Home
CPU:
Minimum Intel Duo CPU 2.0 GHz or above
RAM:
4 GB DRAM or above
HDD Size:
At least 250 GB for recording storage
Network:
Gigabit network
Username and password
Default username and password for various devices are described as in the table:
Device

Admin

Admin pass.

Oper

Oper pass.

Guest

Guest pass.

IP Cameras

admin

pass

None

None

guest

guest

DVR/NVR

admin

1111

None

None

guest

2222

AiM3.0 Software

admin

EMPTY

operator

EMPTY

guest

EMPTY

Benchmark Environment:
PC network card—Gigabit network card
Gigabit hub * 1

Hardware Accessory Support List
Graphics Card for Supporting 6 Monitors:
ASUS 7970-DC2-3GD5 is tested and verified for support 6 monitors virtual matrix output.
USB to RS-232/RS-485 for Acumen Ai-CO99 Keyboard or RS-232 POS
RS485/USB converter
RS-232 to TCP/IP for RS-232 Access Control, Ai-CO99 Keyboard, and RS-232 POS.
CYT-100SC RS485/RS232 to TCP/IP Converter
Ethernet Digital Remote I/O
ioLogik E1210, E1211, E1212, E1214
Ethernet Cash Drawer
APG-480/APG-490
Video Decoder
Acumen AiP-D6
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AiM3.0 Software Specification
Application

AiM 3.0 & RAID

Recording

64 bits
Schedule / Motion detection / Manual recording

Live

Up to 108 channels after registration

Speed

Up to 400Mbps upload and download

Resolution

Up to 4K 30FPS and 2MP at 120FPS

Schedule

7 day * 24 hrs time table, recording mode configurable

Alarm recording
ONVIF
NAS
RAID failure notification
Playback
Speed
Compression
Search

Face detection, audio detection, tampering, motion, DI alarm detection
Licensing
Yes
LSI driver integrated
Time search, event search, date search, POS SmartSearch, and motion SmartSearch
FR: 2x, 4x, 8x, 16X 32X / FF: 2x, 4x, 8x, 16X, 32X
H.264 / JPEG
Date, time, event, POS SmartSearch, motion SmartSearch, plate search (optional)

Tagging

Video tagging for overwritten protection

Multiple channel playback

Up to 36 channels & grouping playback

Remote playback
Video Input
Camera name
Channel editing
Digital zoom
Low bandwidth mode
Multiplexer
Split screen
2 x 2 video wall
Video decoder
Corridor mode

Remote multiple channel playback for SD card, NVR/DVR, and AiM3.0
Acumen IP camera, IP speed dome, DVR/NVR, AiM3.0 Software live server
20 characters
Mouse drag-n-drop
Yes, ePTZ supported for live and playback
JPEG snapshot input and record
Sequence
4, 9. 16, 25, 36
Yes
Acumen AiP-D6 for video wall
Yes

Alarm
Alarm management
Event
Digital output
Alarm scheduling

PC sound, redirect IP camera DO, eMail snapshots, redirect a PTZ preset recall
Various alarm log, video loss, stop recording, schedule, logon, operation log
Third party TCP/IP digital output supported.
Up to four alarm tables with AND logic

Accessories
P/T/Z protocol
Audio
POS/barcode Scan/ATM
Keyboard
Number plate recognition

ONVIF PTZ Supported
PCM/G.711, two-way audio, audio recording
Third party TCP/IP RS-232 supported
Ai-Co98 keyboard controllable via RS-485 for PTZ, ePTZ, and ROI features
Optional

eMap
eMap live monitoring
PTZ control
Alarm

One channel for IP camera/multi-channel for NVR/DVR
Yes
Digital output controllable, snapshots, and alarm popup

DB Manager
Database
Event search filter

Database configuration database import & export, CVS file, report, and maintenance
Yes

Remote Access
Remote NAV Live video

Multiple channels of HD, SD, and low bitrate modes supported

Remote DVR/NVR video

Multiple channels of DVR/NVR supported

Backup
NAV/DVR/NVR

DVR remote backup, AVI conversion and JPEG snapshots

Remote backup

Multiple channels remote backup supported
- 70 Up
- to 108 channels for 4 AiM3.0

Failure over
Archiving

Yes

Management
Access log
User management
Recording calculator

Complete access log in database manager
User authentication: three level: admin, operator, and guest, features configurable
Yes, dynamically calculating available recording days

AiM3.0 Client

Yes

Network
Web interface

Live web interface

Mobile support

iPhone and Android

Protocols
IPScan

ARP / TCP/IP / RTSP / ONVIF / HTTP / SMTP / DNS / PPPoE
Supported, easy-to-setup for IP address

Other
DST

Daylight saving time by Windows OS

Time sync
OS
Language

IP camera and NVR
Windows 7 Home, Windows Vista Home, and Windows XP Home
English, Chinese, Spanish, French, Italian, Japanese, Russian, Portuguese, Simplified Chinese,
Czech, Slovene, German, Turkey, and Hungarian

CPU requirement

Intel E5 or I7

RAM requirement

8GB memory
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